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1. Presentation of the interface

1.1. Main window of the Fault Tree module
The main window is divided into several parts:

» Titlebar: Thetitle bar shows the names of the module and file being edited.
» Menu bar: The menu bar gives access to al the application's functions.

* lcon bar (shortcuts): The shortcut bar isan icon bar (horizontal) which givesfaster accessto the most common
functions.

e Tool bar: Thetool bar (vertical) allows you to select the elements for modeling.
 Input zone: A maximum amount of space has been left for the graphical input zone for creating the model.

» Tree: A treeis"hiden" between input zone and tool bar. It enables to walk through pages and groups of the
document.

Set of tables: Tables are gathered in "hiden" tabs on the right.

LA GRIF 4 - Fault-Tree Module - Treel.jtr [_ O] =]
File Edit Tools Document Fault-Tree Dataand Computations Group Help

0[] [

BEE BE B B BERERE BEBE

1.2. Description of the Menus

1. The File menu contains the standard commands used in this type of menu (open, close, save, print, etc.). The
properties (name, creation date, created by, description, version) can be accessed and modified by selecting
Document properties. The Document statistics provide information on the model's complexity. It is also
possible to access a certain number (configurable) of recently modified files.
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Theicon bar just under the menus proposes shortcuts for most of the File commands:

File|

% New Cirl-N

&= Open ... Ctrl-O

&= == L @ save Ctrl-5
Save as ...

Close Ctrl-F4

~ & Page layout ...

~ & Print ... Ctl-F
Save in RTF file ...
Quit Chi-o

2. The Edit menu contains all the commands needed to edit the model being input graphically.

Theicon bar just under the menus proposes shortcuts for most of the Edit commands:

|
2 Undo ctil-z
2 Redo Chil+Maj-Z
— % Copy CHl-C
- 3 Cut Ctl-%,
y — [ Paste Gl
@ e I || e || I || ] || [?Fl || % | - I?‘pL Paste and renumber Cctl-R

\/' ﬁl Remove Supprimer
Owverall change ...

Selection change ...

Select all Cirl-2,
Properties AltEntrée

3. The Tools menu contains al the commands needed to manage the current model (page management,
alignments, options, etc.).

Theicon bar just under the menus proposes shortcuts for most of the Tools commands:

7 New Page
Page manager ... | E‘ | '% | E‘ UF ’ﬂ ﬂJl
Move to page ...
‘% Refresh
Align ... M = aiigniett” /
Zoom $ Align center
=] Align right
T Align top
View toolsBar ¢ G Align middle
¥ Display state har [Ip Align bottom
Document options
Application options
Connect to a CSV file
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4. The Document menu gives access to all the documents being created or modified.

Document |

Hext
Previous

Ctrl-Fi&

Ctrl+h aj-Fi

¥ C:BusinesswJaGrif 4.08.0 RC1'TreeiTree1.jtr

5. The Fault Tree menu contains all the commands needed to produce the graphical part of the current model.

The vertical icon bar on the left of the application provides shortcuts for each of the Fault Tree commands

(cf. vertical tool bar).

Fault-Tree | 1

¥ Select

[ Gate "And"

O Gate "0Or"

1 Gate "K Out Of N"
[0 Gate "Comment"

[J Elermentany event

O Basic event

I To be developed event
[0’ Home event

[ Hegation

[J Link {onhy one)

[ Links (many)

[T Identical transfer gate
[0 Repeated event

O Comment
[ Dymamic display
[0 Charts

6. The Data and Computations menuisdivided into two parts. data management (creation and management of
the different parameters) and configuration/computation launch (computation time, desired computation, etc.)..

Data and Computations |
Edit Parameters

Update from database ...
Verify

Launch JAaralia ¥2
Launch Aralia W2
Launch JAaralia V4
Aralia V4 data
Launch Aralia W4
Moca data
Launch Moca 12

NB: The Verify function detects any errors in the model: data without values (equal to NaN), events having

the same name, €tc.

7. The Group menu concerns the input and management of submodels grouped into independent subassemblies.

User Manual
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Theicon bar just under the menus proposes shortcuts for two of the Group commands:

Group |

Group
Change name Fz
Ungroup

I~ % Edit group

= <% Quit group edition

8. 9. Findly, the Help menu accesses the on-line Help, the Help topics and to " About".

1.3. Vertical toolbar

Each operating safety model has its own icons. All the graphical symbols for the fault trees are shown on the
vertical icon bar on the left of the datainput screen.

Fault-Tree
Select

%~ Gate "and”

- Gate "or"

M Gate "K Out OF N*
M7 Gate "Comment™

A Elementary event

Mo Basic event

M To be developed event
M Home event

pJe o[ 1] Dlo]=

Wi

™1 Negation

B Link (onky one)

{7 Links {(mamy)

¢ Identical transfer gate
»_| Repeated event

b | Comment

¥ Dymamic display

| Charts

ElEl 3

A

IS B

The vertical toolbar contains the following items:

» Select selects the desired elements.

» "AND" gate to add alogic gate of the type "AND" (represented by a flat-based geometrical figure).

» "Or" gate to add alogic gate of the type "OR" (represented by a curved-based geometrical figure).

» "K out of N" to add alogic gate of the type "K out of N" (represented by a geometrical figure with a double
flat base).

» "Comment" gate toinsert ablock (represented by arectangle) containing only comments in the model.

» Elementary event represented by a diamond shape.
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» Basic event represented by acircle.

» Tobedeveloped event represented by two diamond shapes, one inside the other.

» Home" event represented by a shape vaguely resembling a house.

» Negation represented by asmall circle.

» Link (oneonly) to create one connection (and only one) between an input (gate) and an output (gate or event).
» Links(many) to create connections between the inputs (gates) and the outputs (gates and events).
* |dentical transfer gate represented by atriangle.

» Repeated event represented by acircle.

» Comment to add text directly to the graphic.

» Dynamic display to display the value of amodel element.

» Chartsto draw charts representing computations on the model.
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To enter the different Gates, sel ect the corresponding symbol on the vertical toolbar. A new element isthen created
whenever you click right on the graphical entry area. Each of the model's gates has five parameters:

1. A number: These numbers are, with the type, the gates true identifiers (those which will be used by the
computation engine). That is why, when you wish to change the numbers of certain gates, you must remember
that two gates cannot have an identical number. They are automatically incremented as new elements are
created.

2. A name: It isaparameter which is defined automatically and which cannot be modified by the user. The name
of each gate consists of its "type" followed by its "number" (e.g.: "And1" or "KofN3").

3. A"K out of N" integer: Thisfield isonly accessible in the case of K out of N gates. It allows you to choose
the value of K (K equals 1 by default).

4. A comment: This field adds text inside the gate. This function makes the model more legible (by giving the
specific features of these elements).

5. A type: When a gate has been created, its type can be modified to one of the five types available in the drop-
down list.

+«— Comment

Comment 1
@ il +— Name

Comment 2

" ﬁm

14|B (DD

Comment 2

Comment 4

‘ Rk

To enter the model's Events, select the corresponding symbol on the vertical toolbar. A new element isthen created
whenever you click left on the graphical entry area. Each of the model's events has five parameters:

1. A number: These numbersare, withthetype, the events trueidentifiers (those used by the computation engine).
That is why, when you wish to modify the numbers of certain events, you must remember that two events
cannot have an identical number. They are automatically incremented as new elements are created.

2. A name: The default name assigned to the eventsis Evti for the"i" the element created. Y ou are recommended
to replace this name by something more mnemonic to increase the model's legibility.

3. A comment: Thisfield adds text inside the event. This function increases the model's legibility (by giving the
specific features of these elements).
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4. Alaw: Thiselement isused to model the event's random aspect. Y ou can choose from twenty-three laws which
must then be configured (cf. detailed description of the laws later on in this document).

5. A type: When an event has been created, its type can be modified from the four types available in the drop-
down list.

«—— Comment

Comment vt 1

<> ——— Number

e 4+——— Name

exponential 1E-3

T

™ Law

Comment evt 2

o

Ewtl
exponential 162

D¢ |0|C

Comment vt 3

©

Evt3
exponential 1E-3

Comment evt 4

()

Ewtd
exponential 162

When the gates and events have been created, they must be interconnected to establish the tree's logic. There are
two possible types of connections:. "gate -> gate" and "gate -> event" connections. To make a connection, proceed
asfollows:

1. Click the corresponding icon on the vertical toolbar.

2. Select the start gate by a click left on the specific zone (a dot for "AND" gates, a cross for "OR" gates, etc.)
and keep the button pressed.

3. Move the mouse to the element to be connected.

4. Release the mouse button.

Commert 1

@Pﬂdl
;

Comment evt 1

%

Ewt1
exponential 162

NB: Theaboveicononly allowsasinglelink to be created at atime. If you wish to create several linksin succession
without having to reselect the link creation icon each time, use the icon shown below: Links (several).

'_L|
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2.1.4. NOT gate
It is avery specific gate which inverts the logic of the subtree which is downstream of it.
Toinsert a"Negation" in atree, proceed as follows:

 changethe type of an existing gate by using the drop down list;
» OR create a new a new gate with the type "Negation™:
1. Click left on the corresponding icon on the vertical toolbar.
2. A new element will then be created whenever you click |eft on the graphical entry area.

3. Youthenjust haveto configure and connect the "Negation" like a conventional gate: link the top part (above
the circle) to the bottom part of a gate and link the bottom part (below the circle) to the top part of an event
or gate.

i} E #} Meg1

2.1.5. Entering Comments

To add acomment anywhere on the chart, click the pencil icon and place yourself on apoint in the graphical input
zone. The Comment dialogue box opens where you can enter the desired comment.

Note: Character "%" is areserved character, it must be type twice "%%" in order to display "%".

8 Comment E3

Mevy system

i N
[New systerm,

— :

l/’j-\l J/fl\\tn s ,’/:-‘\l mKoﬂ-

2.1.6. Dynamic fields

It may be useful to observe the change in the different parameters of the model. To do this, use dynamic fields by
selecting the corresponding icon on the vertical tool bar:

The dynamic fields are a type of "improved comments'. They can be used not only to enter words or phrases but
also to insert model values.

o date;
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 value of aparameter (you select the parameter from adrop-down list).

8 Comment [ x|

| o | cawa | wew

When you have made your choice from the five types of elements which it is possible to observe, a piece of code
isinserted in the text part. This will give access to the parameter value. If the dynamic field inserted does not
correspond to any of the model's elements (variable which no longer exists, place number not assigned, etc.) then
the inscription undef is displayed.

Note: To differentiate them, the dynamic fields are displayed in red (unlike the comments which are displayed
in blue).

Note2: Character "%" is areserved character, it must be type twice "%%" in order to display "%".

Example of adynamic field allowing the value of a parameter X to be observed:

1
) Commenk E

alue of Lambdal = %Petri1 2ValueOfCst Lambdal %
2 alue of parameter

[ o | cmxa | vew |

2.2. Configuring the elements

All the graphical elements can normally be edited with a double-click on them or using the Edit - Properties
menu, or using the shortcut Alt + Enter.
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2.2.1. Configuring the gates

When you click right on agate, you can modify any parameter (except the name):

L8 propetties E3

| ok | cael | wap |

* change the number;
» specify thevalue of K if the gateisa"K out of N" type;
* read and/or modify the comment part;

» modify the type of gate to one of the five types available in the drop-down list:
* "OR" gate: an "OR" type logic gate is applied to the elements connected downstream.
« "AND" gate: an "AND" type logic is applied to the elements connected downstream.
« "K of N": a"K of N" typelogic is applied to the elements connected upstream.

« "Comment" gate: this gate has no effect from the logic viewpoint and is only used to comment on the branch
whereit islocated.

« "NOT" gate: cf. above.
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2.2.2. Configuring the events

When you click right on agate, you can modify any parameter (except the name):

= Properties

* to change the number;

* to enter the event name;

* toread and/or modify the comment part;

* toread and/or modify the law gover ning the event.

+ to modify the type to one of the four available typesin the drop-down list:
« Elementary event;
» Basic event;
* To be developed event;
» "Home" event.

The names of these events simply have a "graphical" impact on the tree structure. There is no impact on the
logic function which will be generated to perform the computations. The aim is simply to simplify re(reading)
the fault tree

Thelaw part is configured in several steps:

1. Choose the law from the twenty-three available in the drop-down list.
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2. Configure the law (adrop-down list of the modul€e's parametersis available for each field to befilled in).

3. Uncertainty computations can be introduced for each of the parameters, with a choice of the law and of the

corresponding parameters (cf. later on in this document: a detailed description of the uncertainty computations
on the parameters).

= Law choice

CHE | B

Bometayews <
| o | cawa | wew |

2.3. Data Editing Tables

2.3.1. Description of the Tables

To create or modify data (parameters, variables, etc.), tables are available in the Data and Computations menu.
All the GRIF 2011 data tables operate in the same manner.

Edit Parameters

[ S X
Mame

Lambdal 1.5E-4

Lambdaz 4.0E-4

0] 0.0114

T e

Marme Localization

The data editing table/pand is divided into 3 parts:

» Thetop part containing the buttons.
» The main part containing the data table.
» The bottom part indicating what the selected datais used for.

lE'ﬂ Savesthetablein atext file.

Opensthetablein atext editor (that defined in the Options).
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BB Opens the column manager.
a When the display selection button is pressed, aclick in the table leads to the selection in the input

area.

“F Displays the data filtering part.

E Multiple modifications made to all the selected data.

e Creates new data.

......

}( Deletes the selected data (one or many).

Enables datafiltering or not.

Filtrer

Defines the filter to be applied to the data.

Filtering allows you to display only what is necessary in atable. Several filtering criteria can be combined, as
shown below:

Creation of data filter
Associate tests with: @ AND ) OR Add a criteria:
|Value |v| |greater than |'| |1 a
|Name |v| |cuntains |'| |a|
| 0K I Cancel | Help |

Select AND or OR to choose the type of association between each line (filter criterion). A line is a Boolean
expression divided into 3 parts:

1. thefirst isthe column on which the filter is used;
2. the second is the comparator;
3. thethird is the value to which the data will be compared.

If the Boolean expression istrue, the data will be kept (displayed); otherwise the data will be masked. When the
filter is enabled its value is displayed between < and >.

The datain a column can be sorted by double clicking the header of this column. The first double click will sort
the data in ascending order (small triangle pointing upwards). The second double click on the same header will
sort the column in descending order (small triangle pointing downwards).

A table can contain many columns, some columns may be unnecessary in certain cases. The "linked to database"
column is unnecessary when no database is available. It is thus possible to choose the columns to be displayed
and their order. To do this, click right on atable header, or click the Columns Manager button, the following
window opens:
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Columns manager

Select columns that have to be displayed and their order

vIMame
[v]value
[Linked to +

[ |Dimension 4
I ]Last datahase

[] Desactivate data sorting (fastest)

| 0K I Cancel | Help |

You can choose the columns to be displayed by selecting (or deselecting) the corresponding check boxes. The
arrows on the right are used to move the columns up or down in the list to choose the order of the columns. The
Disable data sorting check box disables the data sorting. Thisimproves the application's performance with very
complex models.

To modify data, double click the box to be modified. When several lines are selected (using the CTRL or SHIFT
keys) changes can be made to all the selected data by using Multiple changes. A window then opens to allow
you to make these changes.

Multiple changes
Multiple changes of Parameters
Field Yalue
Marme
Walue
Linked to
Dirmension Other
Last database
| 0K I Cancel | Help |

Items which cannot be modified are greyed. The white lines indicate that the selected data does not have the same
value for the field in question. A new value can be entered which will be taken into account for all the selected
data. The lines with no background colour indicate that all the selected data has the same value for this field (in
this example the selected datais al "Float"); they can be changed to give a new value to al the selected data.

The bottom table in the data table indicates which elements in the model use the selected data. The first column

of this table gives the name of these elements; the second indicates their location in the document (page, group).
Clicking on alinein this bottom table opens the page where the element is located and sel ects the element.

2.3.2. Arrangement of tables

As said before, tables are available in Data and Computations menu, In this case, each table is openned in a
separate window.

To decrease number of openned windows, tables are gathered in a tabbed pane at the right of the application. The
pane can be "hiden" with the little arrows at the top of split-pane.

User Manual 17/ 63



M=
y & |2 %
P
HIE: T L
4 q:m Parameters
TN
] Filter
ol mame [ value | Link. | Dirn. |Last ..
ILarnbdat 1.5E-4 Other
SlLarmbdaz 4.0E-4 Cther
b no114 Cither
i mame ] Localization ]
ol | |

320 Q ToTAL

Y ou can chose displayed tables with aright clic on the title of the tabs.

2.3.3. Table Cleaning

Datamay not be used anymore, it can be used usefull to delete every unused data. To facilitate removal, use Data
and Computations/ Unused data deletion menu.

Unused data deletion

Following data are not used in model:

Parameters
Lambdal
Lamhda2
Wy

| Select all | | Unselect all |

Select data you want to delete and click OK.

[ ok | cancer | mew |

Thiswindow displays unused data. Select data you realy yan to delete and click OK.

2.3.4. Data creation

The Parameter editor isusedto create"rea" parameters. The following window is only used to choose the name
of the new parameter. Its value must be entered later directly in the parameter table.

Enter name of parameter

| _oc | amnuier |

2.4. Arborescence

“f Filtre

[ htySystern.
¢ [CJPage 1
Gl
o= [ Sub-Grpl
o= ] Grp2
[ Fage 2
[ Page 3

e Tl
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To help users to walk through the document (pages, groups ans sub-groups), atree is available of the leaf of the
application. By default, every element is displayed, you can use Filter button in order to select elements you want
to display or not.

Y ou can expand or collapse a node in arecursive way with aright click on the node.

As explained for tables on the right, you can "hide" the tree.
2.5. Using shortcuts

2.5.1. Identical Transfer Gates (or Shortcuts on gates)
The concept of ashortcut (or repeated element) was introduced in the Fault Tree module for four main reasons:

» Tolink together portions of the model;

» Toavoid graphicaly complex model, and keep readability;
» To simplify the use of the Group function (cf. below);

» To highlight what is essential and what is not.

Let afault tree contain three base events, one "OR" gate (critical event) and one "AND" gate.

ER

C‘ié ar

SEMSORS

@m

%@5

Sensar 1 fails Sensar 2 fails

Q 0

Ewtl Ewt3

The aim here isto create a shortcut to the gate (identical trasfert gate) called "And2" to be able to dissociate the
"And2" subtree from the main tree. Proceed as follows:

1. Delete the existing link between gate "Or1" and gate "And2".

2. Click left onthe Transfert Gate de labarre d'outils verticale puis cliquer sur la porte "And2".

SEMZ0ORS

Sensar 1 fails Sensar 2 fails
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3. Connect the shortcut created in this manner to gate "Or1".

ER

C‘ié ar
SEMSORS

[
LS
- Name of the gate of origin
O A
Page 1 -
Euvt1

— Page number of the gate of origin

Sensar 1 fails Sensar 2 fails

Q 0

Ewtl Ewt3

The name of the original gate and the page number where the original gate islocated are shown beside the shortcut
to gate "And2".

Although linked from the "computational logic" viewpoint, the two trees are now totally graphically independent.
They can now be placed on different pages or in different groups (cf. later on in this document).

2.5.2. Repeated events (or Shortcuts on events)

From the logic viewpoint an event can have an "impact” on several "branches" of the same tree. To correctly
model this case, this event must be duplicated. To do this, select the corresponding icon on the vertical toolbar,
then click the event to be duplicated:

~ Name of the event of origin

The event which has just been duplicated is now marked in dark grey whereas the duplicated event is shown in
light grey. The name and number of the original event's page are shown beside the shortcut.

The repeated event must now be inserted in the model, given that at each instant its state will be equal to that
of the original event.

NB: Obvioudly, if the original event is deleted then the duplicated event is a so deleted.

2.6. Page and group management

The use of shortcuts alowed us to obtain two Fault Tree which have no graphical link between them. They
communicate only by shortcuts. This can be used, for example, to place each subpart on adifferent page:

1. Create anew page by clicking the corresponding icon in theicon bar (or use menu Tools - New Page). A page
number 2 is thus created.
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2. Return to page 1 by selecting the page using the page selector in the ideographic command bar (or use menu
Tools - Page manager).

3. Select the part to be moved.

4. Open menu Tools - Change page.

5. Select page 2 and click OK. The part selected is transferred to page 2 but it continues to communicate with
page 1 viathe shortcuts.

Note: For large models the division method described aboveis very useful.

Another possibility for entering large Fault Tree is to use the Group concept. This is made possible by the
shortcuts and the fact that the datais global for a document. This allows quite separate subparts to be created:

1. Select a subpart.

2. Use menu Group - Group. A dialogue box then opens asking for the name to be given to the group being
created.

3. Enter the desired name and click OK (e.g.: "System 1"). The group is created: the subnet is replaced by a
rectangle assigned with the chosen name.

Y ou can a'so create an empty group with Group - New Group menu or group tool in the left toolbar.

Group

Group

b S ¢

Each group can then be edited, renamed or ungrouped using the commands in the Group menu. The group can
also be edited with a click right or using the "cursor down arrow™ on the left of the page manager. In Edit mode,
the submodel can then be modified as you wish. When the modification is terminated you return to the previous
figure by exiting group editing by menu Group - Quit Group Edition, or using the "cursor up arrow" on the left
of the page manager. It's also possible to choose a picture for a group by using Group - Change Picture menu.

Note: Groups can be grouped recursively.

2.7. Data Entry Aids

To simplify model creation the Fault Tree module has different data entry aids to automate time-consuming
operations.

2.7.1. Copy / Paste / Renumber (without shortcut)

To assist with the entry of the repeated parts of the Fault Tree "Copy / Paste and Renumber" mechanisms have
been provided. This operation is carried out in 6 steps:

1. Select the part to be copied.
2. Click the Copy icon, or use menu Edit - Copy or the shortcut Ctrl + C.
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3. Click the Paste and Renumber icon, or use menu Edit - Paste and Renumber or the shortcut Ctrl + R.
4. A window appears where you choose the start number for the renumbering.

5. The previously selected part is copied and the copy is selected.

6. Move the copy to the desired location.

We then obtain the tree shown in the figure below:

» Orland And2 gates from original tree are become Or 3 and And4 for the copy;
» Evtl, Evt2 and Evt3 events from original tree are become Evt4, Evt5 and Evt6 for the copy.

== IV e B
@ @

| | I 1
I |
Ls SENSORS E LS X i SENSORS |
[l I |
1 ) |
o G- MO O
1 o —Jd .
Evtl e____Ewa__
| | N I l__.

Senzor 1 failz Senszor 2 failz

o oJ\ o9

Q)

When copying to a new document, any data conflicts are handled in the following window:

=4 Data conflict E2

|
|
|
|
|
|

This window shows al the data which has the same name in the source document and the destination document.
There are three choices:

1. Use data of destination document, this will replace the occurrences of the data in the source document by the
data with the same name in the destination document.

2. Create acopy for each datain conflict, thiswill replace the occurrences of the datain the source document by
a copy with a name with the suffix "copy".

3. Manually manage conflict, this allows you to choose whether you use the existing data or not, depending on the
data. Y ou can aso specify the name of the copy by double clicking on the box in the "destination document"
column. The namesin this column are normally masked when the Use existing check box is selected, since it
isthe datawhich is already in the destination document which will be used.
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2.7.2. Copy / Paste / Renumber (with shortcut)

The"Copy / Paste and Renumber" command creates new "instances' i.e. new subtree similar to the subtree copied:
» Same graphical structure;

e Same parameters,

» The number and name of the events and gates change (new name: Evti for events and " type of gate"i for the
gates, wherei isthe new number).

e Same comments.
When identical transfer gates are part of the selection to be Copied / Pasted and Renumbered, they will then remain

unchanged for the copy. They shall always point to the same gate if this gate is not part included in the selection
to be copied.

4 - N O T

|
|
|
|
or1 1 or3
TR = N .

| N N 1

SENSORS

& NCAVES

i
N

In the above example, gate Or 1 an event Evt1 have been renumbered normally. The shortcut to gate And2 has
not been modified.

When a gate that part of a shortcut is also part of aselection hat is going to be "Copied /Pasted and Renumbered"”
and if the shortcut itself is not present, then the gate will be renumbered in the conventional manner.

4 N T ] )

| | >, .

Sensar 1 fails Sensar 2 fails

\@ Q/ k---w----; .E\nﬁ/

In the above example, all of the events and gates have been renumbered normally.

When identical transfer gate (and their corresponding origina gate) are included in the selection to be "Copied /
Pasted and Renumbered”, then new shortcuts will be created and they will be linked to the new gates.
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SEMSORS
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Page 1

Sensar 1 fails

Sensar 2 fails

&
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: Sensor 1 fails : : Sensor 2 fails :
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| |
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In the above example, the gate that islinked to ashortcut has been renumbered (And2 -> And4) and so its shortcut
has al so been modified.

Y ou can navigate between an element's different shortcuts, using menu Tools/Navigate to shortcuts. A window
opens and displays the list of shortcuts. Clicking on a shortcut automatically positions the view on this shortcut.
Y ou can return to the original element by clicking on its name at the top of the window.

2.7.3. Ordinary Copy/Paste

In addition to the "Copy / Paste and Renumber" command there is an ordinary "Copy / Paste” function. It is used
to make a single copy without renumbering. We thus obtain double elements which, from aformal viewpoint, is
incorrect but which must be temporarily tolerated to simplify data entry.

Where possible, the " Copy / Paste and Renumber" function must be used in preferenceto the simple " Copy / Paste”
function to minimise the risk of errors. But when it is used you must take the necessary precautionsto re-establish
the correct numbering to eliminate the duplicates.

2.7.4. Overall change

When creating the Fault Tree it may be necessary to change alarge part of the elements in the models. changing
the names, numbers, etc. The "Replace al" function in the Edit menu allows you to perform overall changes:

» Usethe Edit / Overall changes function.
» Choose the type of elementsto be modified among available tabs.

* The "Find / Replace" part changes a character string present in one or more variable labels, place labels or
transition labels. It is replaced by the string entered in the "Replace” part.

» The"Renumber" part only concernsthe places. It isused to change place numbers. Y ou indicate a Start number
then specify a constant Step, or Add a constant val ue to the current numbers.

» Click OK to return to the chart. The changes are validated.

Note: The name changes and renumbering can be done manually if the necessary precautions are taken (avoiding
duplicates, etc.). You click the Future number or Future name column and enter the change. Do not forget to
validate it with the "ENTER" key.
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L8 GRIF 4 - Fault-Tree Module

| Presentnumber  Presentname  Futrnumber  Futrname
1 1
2 2

I TN O
| Fopce [ Replaceal |

| o | caes  ew

2.7.5. Selection change

The "Replace selection” function is equivalent to a"Replace al" but only applied to the selected elements. Only
the selected gates and events can be replaced.

NB: The "Replace selection” function does not allow the model's parameters to be replaced.

2.7.6. Document properties / Images management

File - Doucument properties menu enable to save information about document : name, version, comment, ...
These informations are available in General tab.
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=% Document properties

e lved
12300456

CHU

101 0/2007

| o | cwes | mew |

Images may bevery useful to represent sub-system. GRIF 2011 enablesto save imagesthat can be used in different
parts of software (groupes, prototypes, ...). Images management is made in | mages tab.

=4 Document properties E

Compipg CADocuments and Seftingsic...

| o | cawe | mw

e

To add anew pictureinto document, use - icon. A double click in File column enablesto select an picture (jpg,
gif or png). A double click in Description column enables to give a name or a description to selected image.

Once in document, picture can be linked to a groupe with Group - Pictur e change menu.

Images are saved indide document, pay attention to picture size. Because images are inside document, you have
to re-add pictureif pictureis modified erternaly.
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To improve the legibility of the model the selected elements can be aligned vertically or horizontally. To do this,
use the Align command in the Tools menu.

The following figure shows how the command works. For example, to align selected places and transitions
vertically, proceed as follows:

1. Select the elements (places, transitions, comments, etc.) to be aligned;
2. Gointo the Tools menu and select the Align function;
3. Choose the type of alignment: Align center;

4. Click left on the mouse.

T : Tools | r :
: \ ‘"1 New Page ! \
i @Mﬂ i Page manager ... : @Mﬂ i
A P . Move to page ... L .
o - . & Refresh . .
-Corment, Align ... b = align left Lomment,
Zoom $ Align center
e . - = Align right - e :
; E T Align top : !
: @ ! View toolsBar ¥ Gl Align middle ! @ !
! ! ¥ Display state har [ln Align bottom ! :
L Document options - LR
Application options
Connect to a CSV file

Similarly, to align elements horizontally select the type Align middle which aligns the ordinates while keeping
the abscissa constant. The principle isthe same as that described above.

It may sometimes be useful to select several elements located in the four corners of the input zone. To simplify
this type of selection click on each of the desired elements one by one while holding down the Shift key on the
keyboard.

It is sometimes difficult to select an additional part of amodel. To simplify the selection process, select agraphical
element then use menu Select connex part in the Edit menu. The additional part can be selected directly by
clicking on the element while keeping the Control button pressed.

If, during modeling, the page size isinsufficient it can be changed using menus | ncr ease page size, Reduce page
size or Page size in the T ools menu.

Tobeableto create an ordered and legible model quickly, thecrosshair can be used to align the different elements
with each other (but less accurately than the Align function in the Tools menu). The cross hair is enabled (or
disabled) in the Graphics tab of the Option menu.
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The following picture show how to quickly align two element of the model.

e ;Ff
(=r iy

In order to align horizontally, select Align au middle which aign keeping constant abscissa.

When objects are where you want, you can glue aset of object by right-clicking and selecting Glue. Thiscommand
create agroup (agraphical one, not ahierarchical one) with selected objects, so that moving one movesthe others.
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3. Laws and uncertainties

3.1. Description of the laws

A total of twenty-three laws are available in the Fault Tree module. Each of these laws has one or more
corresponding parameters. Hereisalist of the different "types’ possible:

» Probahility: value between 0 and 1 inclusive.

» Rate: value greater than or equal to corresponding to afailure rate.

 Duration: value greater than or equal to 0 corresponding to aduration or to atime.
* Factor: value strictly greater than O.

* Natlnt: integer value greater than or equal to 0.

» Boolean: can take avalue of 0 or 1 corresponding to an option parameter.

* Other: any value.

In the remainder of this chapter, the parameter "types’ will be specified for each law.

3.1.1. ALD/On-demand law (for Albizia: constant law)

Thislaw hastwo parameters: the probability g and theinconditional failureratew of the event. Whatever thetime,
the probability of the component failing is constant.

Parameter:

* ( (Probability)
» w (Inconditional failure rate)

The law is defined as follows:

Q=4

Thislaw generally correspondsto the case where the only failure considered for the componentsisthat of arefusal
to change state (e.g.: Failsto start/stop, etc.).

3.1.2. EXP / Exponential law

Thislaw only has a one parameter: the component's failure rate (supposed to be constant over time). It describes
the timeinterval before the first failure for a non-repairable component.

Parameters:
* Lambda (Rate) = failure rate

The law is defined as follows:
On=1-e"

Thislaw iswidely used sinceit isamost the only one to make it possible to obtain analytical results. In addition,
it describes the lifetime of a non-repairable component very well (at least when there are a large number of
components) when the component is no longer young.

3.1.3. IND / Unavailability law (for Albizia: GLM)

This law describes the behaviour of a component (repairable or not), with (or without) failure to start, using
exponential expressions. It generalises the exponential law with the L ambda parameter (failure rate).
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Parameters:

» Gamma (Probability) = probability of initia start failure (at t = Q)
* Lambda (Rate) = falurerate
* Mu (Rate) = repair rate

The law is defined as follows:

] A A=0(A+ 1) _(,
{_)(f)= - _ A( { )X(Z (A+ 20}t
A+ A+ 1t

The Gamma and Mu parameters are optional. Depending on the case, they can be zero.

* If the component is not repairable, set Mu to zero.
* If the component cannot fail to start, set Gamma to zero.

NB: Thefailureto start is only taken into account at t = 0.

Thislaw hasthree parameters: alpha, beta and t0. It describesthe behaviour of acomponent whichisnot repairable
and which doesnot fail to start. Itsspecific featureisthat it takes account of the component'syoung and old periods.

Parameters:

» Alpha (Factor) = scale parameter
» Beta Factor) = form parameter
* TO (Time) = location parameter

Thelaw is defined as follows:

i
] r—t
O@t)y=1-exp —( 0 J
o

The significance of thislaw is that new distributions can be tested by varying the beta factor:

 If Betaislessthan 1, the failure rate decreases and the law then allows the period when the component is young
to be taken into account.

 If Betais greater than 1, the failure rate increases and the law then allows the component's ageing period to
be taken into account.

» If Betaiseqgual to 1, the Weibull law is equivalent to the exponential law.

Thislaw allows acomponent which failsto be represented according to an exponential distribution law and whose
failure isfound during a periodic test. The repair is then carried out instantaneously.

Parameters:

* Lambda (Rate) = failure rate
» Tau (Duration) = test period (time interval between two consecutive tests)
e TO(Time) = date of first test

Thelaw is defined as follows:

e i <t

) 0
{_)(f) - e,‘{‘g_tu mmdt’]

otherwise
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Hereisasmall graph representing the different phases of the component's "life":

TEST TEST TEST
t=0 To t=TO0 Tau t=Tau +TO Tau t=2Tau + TO
operation operation operation
(law exp(A))

NB: Thislaw isasimplified version of the"TPC / Full Periodic Test" law.

3.1.6. TPE /| Extended Periodic Test law

Thislaw allows acomponent which fail sto be represented according to an exponential distribution law and whose
failureis found during a periodic test. The repair phase is then modelled by an exponentia of the Mu parameter.

Parameters:

Lambda (Rate) = failure rate

Mu (Rate) = repair rate (when the failure has been found during atest)
Tau (Duration) = test period (time interval between two consecutive tests)
TO (Time) = date of first test

Hereisasmall graph representing the different phases of the component's "life":

TEST TEST TEST
t=0 To t=Ti Tau =Tau+TO0 Tau t=2Tau + TO

operation operation operation
(law exp(A)) \ \
repair repair
(law exp(p))

NB: Thislaw isasimplified version of the"TPC / Full Periodic Test" law.

3.1.7. TPC/ Full Periodic Test law

This law allows a periodically tested component to be represented as completely as possible. There are many
parametersin play.

Parameters:

» Lambda (Rate) = failure rate during operation or on standby

» Lambda* (Rate) = failure rate during the test

* Mu (Rate) = repair rate (once the test has shown up the failure)

» Tau (Duration) = test period (time interval between two consecutive tests)

» Teta (Time) = date of first test (ignore parameter value: Tau)

* Gamma (Probability) = probability of failure due to starting the test (ignore parameter value: 0 = starting the
test does not cause afailure)

» Pi (Duration) = duration of test (ignore parameter value: O (instantaneous test))

» X = (Boolean) indicator of component availability during the test (O = component unavailable during the test;
1 = component available) (ignore parameter value: 1 = available during the test)

» Sigma (Probability) = test cover rate (probability that the component failure is detected during the test) (ignore
parameter value: 1 = the test covers all the possible failures)

» Omega 1 ((Probability) = probahility of forgetting to reconfigure after the test (ignore parameter value: 0 =
no reconfiguration problem)

» Omega 2 ((Probability) = probability of forgetting to reconfigure after the repairing (ignore parameter value:
0 = no reconfiguration problem)
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NB : the"ignore parameter value" isthevalueto typeif you want parameter to do not affect component avail ability.

Hereisasmall graph representing the different phases of the component's "life":

TEST TEST
t=T0 t=TO+m t=Tau+T0 t=Tau+T0 -+

operation operation operation
(law exp(A)) \ \
repair repair
(law exp(p))

3.1.8. NRD / No Recovery Before Delay law

This law takes two parameters: arepair rate Mu and a delay Delay. For non repairable components, it gives the
probability of not succeeding to recover the component before adelay Delay.

NB: Thislaw does not depend on the time, it is a short version of a constant law.
Parameters:

* Mu (Rate) = repair rate
* d (Duration) = recovery time

The law is defined as follows:
O(y=e™

3.1.9. GLM / GLM Asymptotic law (for Albizia: asymptotic exponential law)

This law is a variation of the "IND / Unavailability" law. It corresponds to the probability of a "IND /
Unavailability" law computed at t = infinity.

NB: This law does not depend on the time, it is a short version of a constant law.
Parameters:

» Lambda (Rate) = failure rate
* Mu (Rate) = repair rate

Thelaw is defined as follows:

/Lt

o) =

]

A+t

3.1.10. DOR / Dormant

This law has three parameters: a failure rate, a mean repair time and a delay. In addition, it does not depend on
thetime.

Parameters:

» Lambda (Rate) = failure rate
* MTTR (Duration) = average repair time
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* d (Duration) = delay

Thelaw is defined as follows:

—ad _x
Jd—(1—e Y+ AMTTR (1= )

o) = 7
Ad+AMTTR.(1-e )

3.1.11. CMT / Temps de mission constant

Thislaw isa simplified case of the "IND / Unavailability" law. It corresponds to an exponential law with afixed
time given as parameter.

Notel: Thislaw does not depend on thetime, it is a short version of a constant law.
Note2: The parameter Q isoptional.

Parameters:

* Lambda (Rate) = failure rate

* T (Duration) = mission time

* Q (Probability) = optional law

The law is defined as follows:

o) = Q+l-e ™
3.1.12. UNI/ Uniform law
Thislaw has two parameters: and upper limit and a lower limit.
Parameters:
* a=upper limit
* b =lower limit
The law is defined as follows:
t—a)
N1) = (
00 = =)
3.1.13. NLOG / Log normal law
Thislaw has two parameters: the mean and the standard deviation.
Parameters:
e Mu=mean
» Sigma = standard deviation
The law is defined as follows:
: _ (Wi—u? |
| | 5 I
O = 1=[fndt  fH=—T=e 7
0 to~N2m

User Manual 33/63



3.1.14. NORM / Normale
This law has two parameters: the mean and the standard deviation.
Parameters:

e Mu=mean
» Sigma = standard deviation

Thelaw is defined as follows:

1 R \

ov2r

(w0’ ‘
26° |

o =1=[Andr  f(H=

3.2. Uncertainties on the parameters

For each probability law used in the moddl, it is possible to introduce an uncertainty on each of the parameters.
There are three laws avail able to model them:

* "NLOG/ Lognorma" law;
e "UNIF/ Uniform" law;
e "NORM / Normal" law.

NB: Each of these laws is described in the previous subchapter.

Using this method, it is thus possible to introduce the impact of the uncertainties on the data into the final result.
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4. Example of a Fault Tree

Here is a fault tree modeling the behaviour of any safety system with two possible states: "work" / "failed" (or
"available" / "unavailable"). The aim is thus to construct a tree allowing us to evauate the system's mean
unavailability.

ER
or1
Logice Wit WES Relay SENSORS Sub-systems
KofMN3
LS R
exponential Lambdal Gl D 1E4 hiadl |
wlve 1 Senzorl Sub-system 1

B3y

o

51

o

51

perodic-test LambdaZ Test 0 GLhd Gamma Lambdal hduZ perodic-test LambdaZ Lambdal sl 4.32E3 4.32E3 01001 0

“wahre 2 Sensor 2

Sub-system 2
Sh2 52 552

perodic-test LambdaZ Test 10 GLhd Gamma Lambdal bl periodic-test Lambda2 Lambdal bl 4 32E2 10010010

Senzor 3

o

GLh Gamma Lambdal hduz

=Y Edit Parameters [ [O0]

Gamma

Lamhdal 1.2E-5
LamhdaZ2 49.0E-5
hfut 0.0414
hiuz 0.0
Test 87600

The above tree has nine events:

LS
e Number: 1
¢ Comment: "Logic"
e Law: exponential law with "Lambda" = Lambdal.
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« SV1
¢ Number: 2
e Comment: "Valve 1"
e Law: simpleperiodic test law with "Lambda"' = Lambda2, "Tau" = Test and "TO" = 0.

e SV2
¢ Number: 3
e Comment: "Vave 2"
e Law: simpleperiodic test law with "Lambda' = Lambda2, "Tau" = Test and "T0" = 10.

« Sl
e Number: 4
e Comment: "Sensor 1"
e Law: unavailability with "Gamma' = Gamma, "Lambda’ = Lambdal and "Mu" = Mu2.

* 2
e Number: 5
e Comment: "Sensor 2"
¢ Law: unavailability with "Gamma' = Gammea, "Lambda"’ = Lambdal and "Mu" = Mu2.

+ 3
* Number: 6
e Comment: "Sensor 3"
e Law: unavailability with "Gamma' = Gamma, "Lambda’ = Lambdal and "Mu" = Mu2.

* R
e Number: 7
e Comment: "Relay"
e Law: unavailability with "Gamma' = 0, "Lambda" = 10e-4 and "Mu" = Mul.

+ SS1
* Number: 8
e Comment: "Sub-system 1"
e Law: full periodic test law with "Lambda' = Lambdal, "Lambda*" = Lambdal, "Mu" = Mul, "Tau" =
4380, "Teta' = 4380, "Gamma' =0, "Pi" =10, "X" =0, "Sigma" = 1 and "Omega" = 0.

«+ SS2
e Number: 9
e Comment: "Sub-system 2"
e Law: full periodic test law with "Lambda' = Lambdal, "Lambda*" = Lambdal, "Mu" = Mul, "Tau" =
4380, "Teta' = 10, "Gamma' =0, "Pi" = 10, "X" =0, "Sigma"' = 1 and "Omega" = 0.

Thetree'slogic is governed by four gates:

e Divl
¢ Number: 1
¢ Name: Orl
¢ Comment: "ER"
e Type: "OR"
e Divl
* Number: 2
* Name: And2
e Comment: "VALVES'
e Type: "AND"
e Divl
¢ Number: 3
* Name: KofN3
¢ Comment: "SENSORS"

e Type: "K out of N"
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* Divl
e Number: 4
¢ Name: Or4
¢ Comment: "Sub-systems"
* Type: "OR"

In this example, different types of more or less simple laws have been used. It was produced in a short time and
allowed several more or less complex components to be modelled: non repairable, repairable, periodically-tested,
with probability of failure on demand, etc.

Using thistree, we can now run various computations on the different gates or events: unavailability computations,
unreliability computations, etc.
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5. Printing

For printing, you have several commands at your disposal in the File menu File:

» The Page setup function function allows you to choose the page orientation, the size of the margins, etc.

Mise en page

— Papier
Tae: [ -
Souice : I Sélection automatique j
r~ Orientation Marges [millmetres]

= Portrait Gauche: |25.4 Draite : |25.4
 Paysage Haut:  [254 Bas: [%54

oK I Annuler I Impﬂmanle...l

e The Print function initially gives access to a window called Printing properties. Then to another called

Information. And thirdly, a window is displayed allowing you to direct the printout to one of the printers
installed on your computer system.

m Printing properties
Print border
Print filename

Print page number
Print date

[ oK | Cancel |

When you select the Print function, the first box to appear is that shown above. You can then select your
preference: Print border, Print filename, Print page number and/or Print date.

Information
E‘ Print current view
[_]Print current page

[_] Print whole document

Secondly, an I nfor mation window appears. It allowsyou to indicate whether you wish to print the current view,
print the current page or print the whole document.

Impression [ 7]

i Imprimanl

Hom Propriétés.

Etat Prét

Tepe: HP Laser/et 2420 PCL B

Emplacement Bureau Mics

Commentaire I Imprimer dares un fichier
—Zone d'mpression Copi

& Tout Nombre de copies |1 3:

e L

7 Selection
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The Print window will not be described here since it depends on your system.

 Itisaso possible to select the Save to RTF file function. Two windows are then displayed consecutively to
you, called Print properties and | nformation (identical to those of the Print function). Y ou are then asked to
choose the folder in which the RTF file is to be saved.
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6. Computations

The following two computation engines can be used in the Fault Tree module:

* Albizig
« MOCA.

These two computation options are accessible in the Data and Computations menu on the task bar.

NB: Before running atype of computation in the Data and Computations menu, it is absolutely necessary to select
one (and only one) gate which all the computations will be carried out on.

If no gates are selected, the following message is displayed:

Message

6.1. Albizia computations
The computations by Albizia are performed in two main steps:

 genera configuration of compuation;
* reading the resultsin the bank of results.

6.1.1. Configuring the computations
The computation configuration window can be accessed in two different ways: either viaData and Computations

- Computation settings menu or via Data and Computations - Launch Computation menu. The difference
between both isthat, in the second case, the configuration step isdirectly followed by the computation launch step.
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The configuration window which opensis called L auching Albizia computation :

Launching Albizia computation E

Target ‘Tup[s) ‘ b | ‘ |

Computation times
® Automatic list of points between 0 and  |B750
) lterate  From To Step
{1 List of times
[] pisplay discontinuity points Times in
Compute mean value through [0, ] Compute integral through [0, ]

Activate propagation of uncertainty

Number of histories [100 Confidence interval a
Quantiles chosen [bound quantile 0%, bound quantile 90%)]

l/ProbabiIities rMinimaIcuts rlmportancefactors |

Probability (Q)
UFI: Unconditional Failure Intensity (W)

CFl: Conditional Failure Intensity (Equivalent A }

Calculation of time spent in zones

| 0K I Cancel | Help

Probabilities | Minimal cuts rlmpurtancefacturs |

[ ] Number of cuts

[ ] Number of cuts per order

[]List of cuts

[ ] Limit order of displayed cuts | ‘ |

f Prohabilities rMinimaI cuts r Importance factors

[ ] Birnbaum (MIF)

[ Critical (CIF)

[ ] Fussel-Vesely (DIF)

[] Risk Achievement Worth (RAW)

[ ] Risk reduction Worth (RRW)

This configuration window is divided into six parts:

1. Target: specifies the target of the computations. Two choices are possible : Top for the top(s) of the tree and
Selected node for the node currently selected in the tree.
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2. Calcul: specifies the computation options.

Computation times : Iterate From A to B step C: the computations will be performed for values of t
ranging from A to B with a step of C.

Computation times: List of times: the computations will be performed for the values of t givenin thislist.
Display discontinuity points: the computation enginetakesinto account the discontinuity pointsif theoption
is selected.

Timesin: The values entered are supposed to be hours. The unit can be specify among hours, days, months,
years

Compute mean value through [0, t]: the computation engine computes the mean value of each variable to
compute for each computation times.

Compute integral value through [0, t]: the computation engine computes the integral of each variable to
compute for each computation times.

3. Activate propagation of uncertainty: activate the propagtion of uncertainties, and specifies parameters of
computation and wanted results.

Number of histories: Number of histories (Monte-Carlo simulation) that have to be made.

Confidence range at : specifies the percentage of resultats that will be included in the confidence range.
Quantiles chosen : With al results of histoires, the software do a "quantile computation”. But there are
aways many ways to chose bounds of an interval containing X % of the results. Here you can chose "on
the left" (lower bound is minimum, upper bound is the quantile at X%), "onthe right" (lower bound is the
quantile at 100-X%, upper bound is the maximum) and in the middle.

4. Probabilities: specifies probabilities to compute.

Probability (Q):

Unconditional Failure Intensity (W)

Conditional Failure Intensity (Lambda eq)

Calculation of time spent in zones: for the three value aboves, this enabl e gives percentages of times spent
in different intervals. These interval's can be setup with the configuration button. A windowsis displayed for
configuring intervals, by default intervals are selected for SIL computations.

™. GRIF - Fault-Tree Module
Probabilities Zone Names of zones
Probability (Q) Zone for PFD

UFI (W) Zone for PFH

CFI (Equivalent A)

Cancel Help

| 0K

5. Minimal cuts: specifies minimal cut values to compute.

Number of cuts: number of minimal cuts of the system (no maximum order limitation).

Number of cutsper order: summary of the number of cuts for each order (no maximum order limitation).
List of cuts: list of minimal cuts of the system. The maximum order can be set thanks to the Limit order
of displayed cuts option.

Limit order of displayed cuts. specifies the maximum order of the displayed cuts. Cuts with order greater
than the maximum order are not displayed.

6. Importance factors. specifies the importance factors to compute.

* Birnbaum (MIF)

» Critical (CIF)

« Fussel-Vesdly (DIF)

* Risk Achievement Worth (RAW)
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* Risk Reduction Worth (RRW)

6.1.2. Results

The Probabily tab gathers all probability computations. The top part displays the percentage of time spent in
each zone (if needed). Then a synthesis tablea diplays minimum, maximum, mean/average and sum. If it is a
computaion with propagation of uncertainties, a column diplays the confidence range of the average.

™ GRIF - Fault-Tree Module E3

l’ Probability | Importance Factors | Products | XML [ Standard output |

Time spent in zones (Percentage)

PR | UFI
System SIL4 [0 1E-4] SIL3[1E-4,1E-3] SIL2 [1E-31E-2] SIL1[1E-2 1E-1[ SILO [1E-1.1]
Sensor: 1 0.0004% 0.0034% 0.0346% 0.386% 99.5755% -
RevealedSafeFailure_... [0.0011% 0.0103% 0.1095% 99.8791% 0% =
RevealedDangerousF... [0.0011% 0.0103% 0.1033% 1.085% 98.7973% =

Synthesis
(‘PR | UR | LBDEQ |

System Min Max Mean Sum Mean
Sensor: 0 1 0.9473 3.2083E3 [0.9473,0.847 3] -
RevealedSafeFailure_... [0 9.0909E-2 8.9961E-2 7.5806E2 [8.9961E-28.9961E-2] |—
RevealedDangerousF... 0 0.9995 0.8859 7.7601E3 [0.8859,0.8859] —
HidenFailure - 1 0 01 9948 01 3879 T TA01F3 [0 8550 0 83A/49] -

Name |V‘ |Type "|
PR | ur | LBDEQ |
Name :
HidenFailure - 1 :| Type = PR, Name = Sensor: 1 4
RevealedDangerousFailure : 2 :
RevealedSafeFailure 23 3 Time Value Mean Sum Standard De...|bound quanti..|bound quanti..
Sensor: 1 - A|lo a 0 0 0 0 0 o
§§ 2.4E1 6.6971E-2 3.3485E-2 0.8037 0 6.6971E-2 6.6971E-2 =
§§ 4 8E1 0.1254 6.4839E-2 3.1123 0 0.1254 0.1254
§§ 7.2E1 01772 9.3658E-2 6.7434 0 01772 0.1772
§§ 9.6E1 0.2236 0.1203 1.1563E1 0 0.2236 0.2236
§§ 1.2E2 0.2658 0.1452 1.7426E1 0 0.2658 0.2658
§§ 1.44E2 0.3044 0.1685 2.4268E1 0 0.3044 0.3044
§§ 1.68E2 0.3401 0.1905 3.2002E1 0 0.3401 0.3401
§§ 1.92E2 0.3733 0.2113 4.0563E1 0 0.3733 0.3733
§§ 2.16E2 0.4043 0.231 4.9895E1 0 0.4043 0.4043
2 4E2 0.4335 0.2498 5.9948E1 0 0.4335 0.4335 —
2 RAED N ARMG N I357TT T NROE4 [l N AROG N AENGC -
mercredi, 26 janvier 2011 16:31:35 CET %
Save and exit I Exit without saving ‘

Importance factor s tab displays importance factors for each events and for each system.

Products shows results of cuts/products computations. In synthesis, a cut with a 0" order, means that the top
event isawaystrue. It may happen if some parts are "forced to 1".

XML tab contains Albizia output.

6.2. MOCA computations

The computations by MOCA are performed in three main steps:

* general configuration;
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» computation launch;
* reading theresultsfile.

6.2.1. Configuring the computations

The computation configuration window can be accessed in two different ways. either via menu Data and
Computations - Moca Data or via Data and Computations - Launch Moca 12 .... The difference between the
two isthat, in the second case, the configuration step is directly followed by the computation launch step.

The configuration window which opensis called General I nformation:

B Launching Moca computation

Title [FPetritjnp |

Default compute times

) Times or list of times {(separator =",")

@ Kerate From |0 | To [pren | step |20

Computation made at: ‘t (after triggering transition) ‘ - |

fGeneraI rVariahIes |/ Qutput Options |/ Advanced Options |

Mumber of histories |10
1st random Number |1 2345681E7
Maximum calculation time (sec.) (10.0

Automatic history duration

[ ] Multi-processors computing [

[ ] Activate uncertainty propagation

0], I Cancel Help

This configuration window is divided into five parts:
1. Title: allowsyou to give atitle to the results file.

2. Default statistics configuration: defines the types of computations which will be performed by default for
all the statistic states.

3. Default computation timesfor statistic states:

» IterateFrom A to B step C: the computations will be performed for values of t ranging from A to B with
astep of C.

 List of times: the computations will be performed for the values of t given in thislist.

<listitem>

Computation made at: by default, computations are made immediatly after trantion triggering, but you can

do computation et t-Epsilon (just before triggering), or at both.

</listitem>

4. General:

* Number of histories: Number of histories (NH) to be simulated (each history has atimet indicated below).
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» First random number: It isthe seed of random number generator.

e Maximum computation time (MT): The computations are stopped and the results are printed even if the
reguested number of histories has not been reached.

Note: the unit of time (MT) is the second.

» Automatic history duration: If this box is checked, GRIF will compute history duration using computation
time of variables and statistical states. If not, user can choose a specific History duration

* Multi-processor s computing Enables (or not) the multi-processor computing (when available).

» Activate uncertainty propagation Enables (or not) the uncertainty propagation computations (two-stage
simulation): in this case we must specify the number of sets of parameters "played" (the real number of
histories thus simulated will be the "number of sets of parameters x number of historiesto be simulated” and
will be displayed in the "Total number of histories" field).

5. Variables: Thistabsreminds comuting configuration of variables. If document contains some statistical states,
another tab isavailable.

6. Output: used to configure the output.

Prints the description of the Petri Net in the results file (or not)

» Printstheresultsfile allowing it to be loaded using a spreadsheet application (such as EXCEL)
Prints the censored delays (or not)

» Number of outputs during simulation. If 2 outputs, there will be an output at NH/2 and at NH.

7. Advanced options: used to configure the advanced options.

 You can choose the limit of transitions fired at the same time before loop detection.

When the configuration part has been carefully completed, you reach a window allowing you to launch the
computations. This window has two tabs: Data and Results.

6.2.2.1. Data tab

The Data tab displays the MOCA-RP V12 input datafile (file type: ".don"). In addition to being able to modify
thisfile manually, there are four buttons available allowing you to perform the following operations:

* Open: opens adatafile;
» Save: savesthe current file;
» Clear: clearsthe content of the current file;
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» Generate data: generates input data from document.

=% Launch Moca 12

set language french ;

et format Grif.Aralia {

Geed-First

SeediCurrent) :

Generate data
o wen |

F-12.

125N %-12.55M" "Transitions

Frequence™

Aninput datafileisafiledescribing the model in Mocalanguage. Thedataentered during the general configuration
step isdisplayed first. Then therest of the fileis divided into several parts (from top to bottom):

1. Gates specification; Each gate'slogic is expressed according to the corresponding subtree elements (gates and/

or events).

Example:
/% Gares specifioatiort

_'_'——u..__
<0rl := (&ndz | B | KofWN3 | Ord | L8):[>
[ — ]
lhndZ2 1="[ow P
KofN3 := B({ 2,[51, 53, $2] 1:
Ord := (352 | $51);
ER
Logic WLWES Relay SEMSORS Sub-systems

O

exponential Lambdal

wa ()
R

GLW D 1E4 0.0HG

KofH2
23

s

In the above example, it is specified that the logic expression at the level of gate Or1 is equal to And2 OR
R ORKofN3OROr4ORLS.

2. Parameters specification: All the model's parameters are listed (name and value).

3. Laws specification: For each block, the law is specified followed by all its parameters.
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Example:

S* Laws specification %/
lawy L3 exponential Lambdal:
law 5¥1 periodic-test Lambdaz Test 0;
lay SVZ periodic-test LambdaZ Test 10:
1 am-F T 0 1E-4 0.04T57

law 31 GLM Gawma Lawbdal MuZ;
law 52 GLM Gamma Lambdal Muaz;
33 GLM Gawma Lawbdal MuZ;

In the above example the behaviour of events S1, S2 and S3 isgoverned by a"GLM" law (in the Albizia sense)
and thus"IND / Unavailability" in the GRIF sense, and its parameters are:

* "Gamma' = Gamma;
» "Lambda' = Lambdal;
s "Mu"=Mu2.

6.2.2.2. Results tab

The Results tab initialy launches the computations and then displays the results file (file type: ".res"). Five
functions are available here via buttons:

» open".res' file;
» savecurrent file;
 clear contents of current file;

* launch computations from graphical interface, awaiting window will be display, it allows to stop computation
if need be;

» launch computations in Batch mode to have permanent access to the input interface throughout the
computations. Computations are launched with low priority.

L8| aunch Moca 12

Computation launching Batch launching
preous |
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For MOCA compuitations, the resultsfileis presented as follows (from top to bottom):

1. Data entered during the general configuration of MOCA:

Title 1 <NULL>
Stories loooo
Geed-First 12345681.00
Seed(Current) 1335337645, 00
[uration loooo. 0o
Times : DUORATION

’ ToTAL

2. List of transitions automatically generated for MOCA (and their firing frequencies from the simulation):

Transitions
fum  MName

So0l.C1
Def.Cl
Rep.Cl
So0l.C2
Def.C2
Rep.C2
50l.C3
Def.C3
Rep.C3

WO -1 hon s L) N

-
=

Def.L3

Frequence

1.00000E4+000
.19100E-001
. 27000E-001
. 00000E4+000
. 24700E-001
. 34200E-001
. 00000E4+000
.18500E-001
. Z26400E-001
.13900E-001

e I T e L

3. List of places automatically generated for MOCA and the associated different results from the simulation:

User Manual

Places

fum  MName
1 I.Cl
2 M.C1
3 P.Cl
4 TI.CZ2
5 M.CZ
6 P.CZ
7 I.C3
8 M.C3
9 P.C3
10 M.L3

MeanTime

0.00000E+000

L e R e e == I ¥ u ]

L 9873ZE4+003
. Z6833E+001
. 00000E+000
. 9866ZE+003
. 33761E+001
. 00000E+000
L 958753E4+003
. 24711E+001
L A2173E+003

Stdbevy MeanMark

0.00000E+000
.060%93E+001
.0e093E+001
. 00000E+000
. 21483E+001
. 21453E+001
. 00000E+000
.99101E+001
.99101E+001
LG991ZE4+003

= o= =0 ;nn O non

StdDew
0.00000E4000

L e R e e == I ¥ u ]

L9873ZE-001
. ZB833E-003
. 00000E+000
.9866ZE-001
. 33761E-003
. 00000E+000
L958753E-001
. 24711E-003
. 42173E-001

= b= D >nn O >nin O

. 00000E+000
.06093E-003
.0e093E-003
. 00000E+000
. 21483E-003
. 21453E-003
. 00000E+000
.99101E-003
.99101E-003
LG991ZE-001
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4. Unavailahility results and unreliability results for each type of statistics requested:

1 = Mean times in states.

Times 1.000000000000E+004

[ame Hean Std-Deviation
Mhdwrail,Out,out 2,004324611157E4003 2.581826234964E4+003
[MnReliab. 0ut. out 9.,990010233429E4003 2.715454299557E-001

2 = Mean of presence of state at the end of an history.

Tines 1.000000000000E+004

Mame Mean Std-Deviation
[Mndwail. Out.out 1. 502000000000E-001 3.572852155807E-001
MmReliah. Jut. out 1.000000000000E4+000 0.000000000000E4+000

3 = Mean walue of the expression at the end of an history.

Times 1.000000000000E+004

[ame Hean Std-Deviation
[Mrdwrail, Out, out 1. 502000000000E-001 3.572852155807E-001
[MnReliab. 0ut. out 1.000000000000E4+000 0.000000000000E4000

5. Computation times.
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/. Curves

The curves can be drawn to study the model and the results better. To do this, click left on the corresponding icon
on the vertical task bar then draw a box. This box will be the space assigned to displaying the curve(s). Initially
it isonly awhite box with two axes without graduation.

Chartsicon:

We must now define the curvesto be drawn. To do this, click right on the box to display the Charts Edit window.

7.1. Charts Edit window

Note: It is important to specify that drawing curves requires a computation to be launched which is completely
independent of that accessible in menu Data and computations- ...

The Charts Edit window is the same for all the GRIF modules

Charts Edit E
Charts title: [Charts |
Data List
& Recompute (X 3
Curve le__Informati..]  Show Color Style Heawy hlgan
Chat!  |PFD Cu... Black Mo paint 11 [
Style

Style type: |Line style =

Automatic interval.

Interval on X, begin : end: [JLog
Interval on 'Y, begin : end: [JLog
Time unit:
Display options

Display title:

Display generic values: [ |

OK I Cancel Help

Thiswindow is divided into several parts:

1. ChartsTitle: allowsyou to give atitle to the graphic.
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2. DatalL ist: Thispart containsathree-column tablelisting the chart's different curves (name, description, display,
curve colour, curve style, curve thickness).Several buttons are available above thistable.
» Recompute: launches or relaunches the computations necessary to draw the curves (this operation must be
performed each time the list of curves or the model is modified).

g,

-h:' H
Add E==1; sends you to a Curve type window to add a curve to the chart (cf. following chapter).
 Edit: modifies the selected curve.

Delete X . deletes the selected curve from the chart.
Up 1 : moves the selected curve upwards in the list.

Down + : moves the selected curve downwardsin the list.

» Save: thelist of points computed for the selected curvein CSV format. This export doesn't contains generic
values. In order to export with generic values, use right-click and select Separate export.

* Duplicate: creates anew curve identical to the selected curve.

* Results: display in atext editor the results of the selected curve.

For each curve, you can specify its colour, its style of points, its thickness and its display options.
3. Computation options: allows you to configure the computation (optional depending on the module used).

4. Style: This part deals with displaying curves.
» Styletype: specifiesthe type of all the chart's curves (line or histogram).
* Intervalson X and Y: Specifies the display interval for the X and Y axes (default interval or user-defined
interval). Thislast function can, for example, be used to zoom in on the most interesting parts of the curve.

The log check boxes are used to enable the logarithmic scale on the axis concerned. Important: O cannot be
represented on a log scale, remember to give a strictly positive starting point (e.g.: E-10). If 0 is given, the
log scale will start with an arbitrary value E-15.

When domain axe deals with time, you can choose time unit among : hours, days, months, years. Default
display is"hours" because it is the usualy used unit for modeling. It's only available in SIL module.

When computation engine allowsiit, you can display confidencerange checking the checkbox.
With historam style, a checkbox allows to do a cumulated histogram.

5. Display options: enables (or not) the Display title function (displays the title of the chart) and the Display
generic values function (displays the min., max. and mean values of each curve).

When a curve is edited, its edition window contains 3 parts : times used for computation, target of computation,
further information (generic values) that be be displayed or not under the curve.

Remark: it's sometimes useful to refresh al charts in document. Use the Tools / Refresh command or press F5

or % icon.

When you click the Add button in the Data list part you reach awindow called Curve type. Y ou then have four
possibilities:

» Use existing results: draws the points that are in bank of results in document. This banks of results contains
every computation made previously.

* Moca 12 Curve: draws an unavailability curve according to the points computed by the Moca 12 engine.
NB: an example curve for each type of computation will be given later.

Whatever the type of curve selected, a window is displayed allowing you to modify the computation times and
types.
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7.2.1. Use existing results

Users must select the result they want to display. Then the must select what will be used for x-axe and for y-axe.

™ GRIF - Fault-Tree Module E2
Legends : || |

Results to be used |Re5u|t5 of last computation ‘ b4 |

Computation target
1/
¢ [C] Gates and Events
9 3 Probability (Q)
D Sensor: 1
o= [ UFI : Unconditional Failure Intensity (W)
o= [[] CFl : Conditional Failure Intensity (Equivalent A )

X-Axe |Time ‘ - |

Y-Axe |‘.r'alue ‘ - |

Value to be displayed

Minimum Maximum Mean

SILD SiL1 SIL2
SIL3 SiL4
| OK I Cancel Help

7.2.2. Moca

When you select Moca 12 Curve, you must then configure the computations using the following window:

L8 Curve Moca 12 E3

The above window bears the name of the type of curve selected (in this case: Moca 12 Curve). It is divided into
four parts:
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1. Legend: to namethe curve.

2. Computation times: time interval and step OR list of times (gives the computation engine the exact point to
be computed).

3. Computation type:
e used to select whether the computation will be an unavailability computation or an unreliability
computation;
» AND used to select the target which is to be the subject of the computation;

4. Computation options: specifies the number of historiesto be simulated.

Here is the Fault Tree which will be used to draw the different curves.

ER

ﬁ*é orl

Logic: W VES Felay SENSORS Sub-systems
FofMN3
L3 R
exponential Lambdal Gl D 1B ol |
“wahve 1 Senzorl Sub-zystam 1

|

perodic-test LambdaZ Test 0

&

&

=

GLh Gamma Lambdal hduz

551

“alve 2

Senzor 2

&

W

periodic-test LambdaZ Test 10

52

GLhd Gamma Lambdal hiuZ

Sensor 3

53

Gl Gamma Lambdal hiuz

It isthe example described previously and which has:

e Qevents
* 4 gates

Each of the following gates represents the system's unavailability (over 10,000 hours) computed at the top of the

tree ER.
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7.3.1. Curve from bank of results

1 » "
08
08
0.7
06
SILO
05
04
03
0.2
0.1
SIL1
o
0 1E2 2E3 3E3 4E3 5E3 GE3 TE3 BE3 BE3 1E4
Hours

ER : Minimum=2.88E-4, Maximum=1, Mean=9.1779E-2

This points are thoses in bank of results. They have been computed during last computation. This picture shows
probability of Top-Event, but you can draw everything you have computed.

7.3.2. Moca 12 Curve

Graph Maoca 12

1 4 4
0E T
0E A

04

" ‘ ILT
2L

IE2 1=] 6E2 2E3 1E4
-Moca 12

Moca 12 Min=0.0036, Max=1.0, Mean=2.03016E-1

The points have been computed at regular intervals (1 every 50 hours). 10,000 histories have been ssimulated for
this graph. Only the first two peaks were found using the 50 hour time step. The third (t = 8760 h) was not taken
into account.

Important NB: For the curves drawn using Moca, the discontinuity points are ignored and thus do not appear on
the graph. However, the mean displayed does take account of each discontinuity point.
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8. Databases

In each GRIF module a connection can be established to a database. It is possible to have two different types of
connections:

» connectionto aCSV fileg;
» connection viaaJDBC link.

8.1. Connection to a CSV file

8.1.1. Form of the database

Thistype of connection isthe simplest to make. A CSV file has the extension ".csv". It isasimple text file where
the different fields are separated by commas, tabs or semi-colons. It isthe simplest form of database.

|ID;NOH;UALEUR; DESCRIPTICN
1:Lpleoowp:0.006; comment 1
2:LpZcomp:0.004; comment2
J:Lp3comp:0.002; comnent3
4:Lpdcomp:0.001; comment4

8.1.2. Connection

To connect GRIF to this database, go into menu Tools - Connection to a CSV file. A dialogue box is then
displayed:

=4 Database E2

18,0 RC1iTreel toolsiDatabaselrex.cov -

D

VALEUR

DESCRIFTION

| ok | camca | Hop |

Thiswindow is divided into three parts:

» You must initially enter the path leading to the CSV file. To do this, there is an explorer available (... button).
A Test function is used to check the connection.

* You must then enter the names of the four fields of the CSV file.
 Finally, specify the types of separators used in the CSV file.

Note: A CV S connection must be made with aCV S File (which means generated from only one sheet of aEXCEL
File).
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8.2. Connection via a JDBC link (example with ODBC connector)

8.2.1. Form of the database

The database can initialy be in the form of an EXCEL or ACCESS file. Then, using the operating system, an
ODBC system data source must be created. In the case of WINDOWS, for example, thisoperationisperformedin
menu "Control Panel - Administration tools - data source (ODBC)". Hereis an example of an EXCEL database:

A B | C | D |
|1 [ID MO WALELUR DESCRIPTION
| 2 | 1|Lplcomp 0.006 | comment1
[ 2 LpZcomp 0.004 comment2
| 4 | 3 Lp3comp 0.002 | comment3
[ikai 4 Lpdcamp 0.001 commentd

8.2.2. Connection

To connect GRIF to this ODBC database, go into menu Tools - Application options - Database. A window is
then displayed which must be filled in as follows:

GRIF 4 - Fault-Tree Module E

org.religue jdbc.csy. CevDriver

1essllaGhf 4.08.0 RC 1 Treel Moolsi\Database

DESCRIPTION

Test Connection

ok cwesvew

Notes:

1. sun.jdbc.odbc.JdbcOdbcDriver isthe driver name

2. jdbc:odbc:REX specifies that "REX" is the name of the ODBC link

3. Thefields Connection options, L ogin et Password are unnecessary here.

4. SELECT ID,NOM,VALEUR,DESCRIPTION FROM [Feuil1$] $] is caled the query where Feuill is the
name of the EXCEL sheet containing the data.
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The aim isnow to link some of the model's parameters to the database. To do this, start by displaying the column
Linked to in the parameters table (click right on the top of the columns).

=3 Columns manager

v Marre
(1]

[w] Linked to

O

[ o | s s |

Then double click in the Linked to column to display the database items. When one of these items has been
selected, click OK to validate the connection. The parameter then takes the value of the item to which it is now

connected.

=% Database

Lambda

Example 1

b

Example 2

Gamma

Example 3

Frodhlas

Remove link to database

| o | e | e

Example 4

Note: The button called Remove link to database at the bottom of the table breaks the link between the parameter

and the database item.
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If some of the database values to which GRIF is linked are modified, the parameters connected to this database

can be updated. To do this, select Data and computations - Update from database... and display the Database
window.

=S Database E2

nselect all Select all Update selection

li
Gamma (id=3) |Gamma
Lambda (id=1) |Lamhda
tu (id=2) M

ProdMax (id=4) ProdMax

[ o | cmw [ e

The parameters whose values are not up to date are automatically detected and indicated in bold. One or more
of these parameters can then be selected for updating using the Update selection button. Two other buttons are

availableto simplify the selection process: Unselect all (deselectsall thetable's parameters) and Select all (selects
all the table's parameters).

Remark: you can also directly copy parameter from database using menu Data and Computation/Database/Copy

parametersfrom database. A window is displayed, you can select parameters you want to copy into document.
Parameter will be automatically linked to the right paremeter in database.
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Hereisasummary of all the data which can be saved from a same model.

It is obviously possible to save and reload the models which
into File- Saveas....

are made. To do this go into menu File - Save or

File|
[ New Ctrl-N
= Open ... Ctrl-0
Save Chil-S
Close Ctil-F
2. Page layout ...

& Print ... Ctil-P
Save in RTF file ...
Quit Ctrl-Q

A model can also be saved in RTF format. This alows the saved model to be reloaded in WORD to insert the
graphical part of the model in any document. To do this, go into menu File - Savein RTF file....

File|
[% New Ctr-N
= Open ... Cti-0
Save Ctr-5
Save as ...
Close Ctrl-F4
. Page layout ...
& Print ... CHl-P
Quit Cirl-0

Note: Thereisanother way to insert model in areport. Select the part of the model, copy it, and pasteit in Microsoft

WORD or other software.

When the input data for the computation engine is generated, it can be saved. This type of file has the ".don"
extension. These files can therefore be modified using atext editor then reloaded to launch computations on them
(for example). This action should be made only by advanced user.

Theresultsfile can also be saved. This type of file hasthe ".res" extension. These files can therefore be reloaded
into another program (e.g. EXCEL) to exploit the resultsin more detail .
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9.5. Curves

For each curve drawn, the points which have been computed in CSV format can be saved. Thislist of points can
then be used to draw new curves or to perform further computations.

Graph 1

| [l [x]§E]
Curveillu.. Informatio..  Show  Color Sl Heaw
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Tools- Application Options menu opens awindow containing the following tabs:

Executables tab enables to specify path to external executables:

» Editor path : Specifiestext editor path.

» Automatically open PDF files: Specifiesif PDF reports must be openned avec generation.

e Style-sheet from XML to DocBook. : Style-sheet alowing converting from XML report to docbook file.
» Style-sheet from XML to HTML. : Style-sheet allowing converting from XML report to HTML file.

» Style-sheet from DocBook to PDF. : Style-sheet alowing converting from docbook file to PDF file.

* Moca-RPC path : Specifies Moca version 12 path.

» Javaw path : Path of javaw.exe executable.

Database tab enables to configure database connection :

» Use DataBase connection for parameters: Select if database must be use.

» Name : Database name will be put into parameter during its update. It enables to know from which database
parameter has been lastly updated.

« JDBC Driver : Enter name of JBC driver to be used(sun.jdbc.odbc.JdbcOdbcDriver,
oraclejdbc.driver.OracleDriver, ...).

» Connection to database : Database Url.

» Connection options : Connection properties.

e Login : Login to be used to connect to database.

» Password : Password to be used to connect to database.

» SQL Request : Request that have to be executed to retrieve data from database.

* Nameof "ID" field : Name of field containing data ID.

» Typeof ID: Typeof ID field INTEGER, FLOAT, VARCHAR(32), ...)

* Nameof "name" field : Name of field containing data name.

* Nameof "value" field : Name of field containing data value.

* Nameof "description” field : Name of field containing data description.

e Test Connection : Name of field containing data description.

Language tab enables to choice language :

» Language : Language changes are taken into account when option windows is closed.Available language are
French and English.

Options tab enables to tune application behavior :

» Saveworking document optionsasdefault optionsin application : Save optionsof current doc as application
default options.

» Application manage default options of documents. Apply defaut options to current document : Apply -
Application options- to current document.

* Number of undo : Specifies number of possible undo/redo.
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* Number of recent files: Specifies number of filesin recent fileslist.

» Window display : Enables separate tables (external) or linked tables (internal).

e Columnsto beresized in tables : Enablesto specify the columns on which space will be taken for resizing.

» Usenet protection key (Red) : Check thisbox only if anetwork key is used (reg key).

* Manage new namesto avoid name conflict : Triesto avoid name conflict, creating new objects whose name
isunik (when pasting for example).

» Synchronise view with tables : Select objectsin tables (on the right) when they are selected in view.

» Synchronise view with explorer : Select objectsin explorer (on the left) when they are selected in view.

» Automatic cutting of imported files : Automacally cuts of tree when a new fileisimported (*.xml or *.dag)

Graphics tab enables to modify GUI look :

» Element Zoom : Changes graphics size.

» Comment size: Changes comment font size.

» Activate cross hair : Activate cross hair which enables object alignment.

» Activate smoothing for texts : Activate anti-aliasing (smoothing) for texts, it can slow the display.
 Activate smoothing for images : Activate anti-aliasing (smoothing) for images, it can slow the display.
» Activatetooltips : Activate tooltip-system.

Digital format tab enables to customize digits display :

» Display of parameters: Specifies the display of parameters (number of digits, ...).

Event tab enables to change event display. :

» Label size: Specifieslabel font size.

 Display name : Enablesto display name or not

» Display description : Enablesto display description or not.

» Display average probability : Enablesto display or not the average probability.

» Display probability at the end of mission : Enables to display or not the probability at the end of mission.
 Display computation time : Enables to display or not the computation time

» Display law : Enablesto display law or not.

* Useadefault law : Enablesto use a specific law as default law.

» Default law : Enablesto define the default law to be used.

Gates/Reports tab enables to change gates/reports display :

» Label size: Specifieslabel font size.

» Display name: Enablesto display name or not

» Display description : Enablesto display description or not.

» Display K/N : Enablesto display K/N or not.

» Display report location : Display the set of reports for agate.

» Display average probability : Enablesto display or not the average probability.

 Display probability at the end of mission : Enables to display or not the probability at the end of mission.
» Display computation time : Enablesto display or not the computation time

» Display report sour ce name : Display name of the matching gate under identical transfer gate.

» Display report sour ce page : Display page of the matching gate under identical transfer gate.
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Charts tab enablesto change charts drawing :

» Set graphicsborders: Add bordersto charts.

» Set generic valuesborders: Add borders to generic values under charts.

» Display grid : Display grid on curves area.

» Display legends: Display legends under curves.

« Drawing zone transparency : Activate curves area transparency.

» Graphic transparency : Activate charts transparency.

» Titlesize: Specifies chartstitle font size.

» Genericvaluessize: Specifies generic values font size.

» Point size: Specifies point size on curves.

» Coordinates size : Specifies coordinates font size.

» Legend size: Specifieslegends font size.

» Max number of points: Specifies maximum number of points to be drawn.

» Max number of pointsto save : Specifies maximum number of points to be saved.
» Draw S.I.L : Horizontal lines are drawn at E-1 E-2 E-3 E-4.

e Savepointsin document : Specifiesif points of charts have to be saved in document.
» Vertical abscisefor histogram. : Display coordinate of abscise verticaly.
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